Chapter 6

CREATING VISUAL EFFECTS

Fireworks provides all of the tools you need to create advanced, sophisticated, wow-your-audience visual effects. In fact, because of the flexibility of the Fireworks toolset, we think you’ll find that creating effects in Fireworks is much faster and flexible than in other design tools. Every object, every gradient, every filter, every everything in Fireworks is infinitely editable and tweakable, giving you the ability to try, change, and remove until you’re satisfied (or exhausted).

Because the term “visual effect” can mean different things to different people, we should probably frame the term and the conversation we’re going to have in this chapter. For this conversation, a visual effect can be something as simple as a simulated reflection to something as complicated as magical glowing particle trails. An effect is really just a combination of techniques that result in a perceptively sophisticated result.

In this chapter, we’ll first look at the building blocks used to create effects and then combine these building blocks to re-create a number of popular effects seen across the Web, print, and modern RIAs or desktop applications. By the end of the chapter, you’ll be creating glassy buttons and headers, reflections, and magic effects like a pro!
Building blocks

Building sophisticated effects is easier than you think—you just need to understand the fundamental building blocks provided by Fireworks. The effects we’re going to create in this chapter rely on gradient fills, texture fills, layer blend modes, filters, and styles. Let’s step through each of these basics quickly, and then move on to the fun stuff!

Gradient fills

Gradient fills are at the heart of most effects and sophisticated user interface skins. The Fireworks Gradient tool is actually one of the features that have made Fireworks the go-to tool in many visual designer’s arsenals. In addition to setting color stops on the gradient, you can specify opacity stops as well. It’s the ability to specify opacity stops independently of color stops that sets the Fireworks Gradient tool apart from gradient tools in other applications. Further, with the introduction of Fireworks CS4, gradients are now updated in real time on the design surface as you adjust gradient handles.

Selecting a gradient type

Changing the gradient type and editing gradients is all achieved through the Property inspector. Figure 6-1 demonstrates how to specify a gradient fill type. The most commonly used gradient types are Linear, Radial, and Ellipse, and these are the types we’ll show you how to use in the tutorials that follow.

![Figure 6-1. Setting the gradient fill type](image)

Editing gradient nodes

Once you’ve selected a gradient fill type, click the Fill swatch to launch the gradient editor. Figure 6-2 shows the gradient editor expanded with an opacity editor launched for the rightmost opacity node.
The top row of nodes represents opacity nodes, while the bottom row represents color stops. Drag nodes horizontally to change their position, drag nodes vertically to remove them, and click between existing nodes to add new nodes. Click a node to launch either the color editor or the opacity editor (depending on the node type). This node-editing interface is the same regardless of the type of gradient you have chosen.

**Adjusting the gradient direction**

Unlike editing gradient stops, editing a gradient’s direction is not done via the Property inspector. Instead, direction editing is performed on the design surface itself. Figure 6-3 shows a rectangle on the design surface with a linear gradient applied. Notice the vertical black adorner, anchored by the circle glyph and the square glyph. This is the gradient direction editor. The circle indicates the start of the gradient, while the square indicates the end of the gradient.

Reposition the gradient by dragging the start point (circle), change the direction freely by dragging the end point (square), or rotate the gradient by mousing over the connector line and dragging when the cursor changes to a rotation indicator.
CHAPTER 6

You can snap the rotation to 45-degree intervals by holding down the Shift key while dragging.

Advanced gradient editing

The default Fireworks gradient editor is fast and easy to use, and is excellent for simple gradients. However, for more complex gradients that employ a large number of gradient stops, it becomes difficult to select the exact stop that you want, especially if you want the stops to be practically on top of each other. This is a common technique for creating sharp, glass-like gradient effects. I created the Gradient panel for Fireworks to address this limitation in the default editor. You can download the Gradient panel from my web site, www.granthinkson.com/tools/fireworks, and install it using the Adobe Extension Manager. Once installed, launch the editor from the main Fireworks menu (Window ➤ Gradient Panel).

Figure 6-4 shows two states of the Gradient panel. The leftmost state is the zoomed out, default view of the panel. The positioning of the nodes here is the same as it would be if you launched the default Fireworks gradient editor. In the rightmost panel, we have zoomed in on the two center color nodes by dragging the zoom slider all the way to the right and the offset slider to the middle. Zoomed all the way in, we can now accurately position these two stops that appear to be right on top of each other in the nonzoomed view.

![Advanced gradient editing with the Gradient panel](image)

For even more precise editing, you can manually enter the offset, color, or opacity in the supporting Color and Opacity grids directly beneath the live preview.
Texture fills

Fireworks ships with a number of textures that are sure to look familiar to you if you’ve paid attention to the artwork used on modern Web 2.0–style web sites. Built-in textures, such as Line-Diag 1 and Line-Horiz 1, are used in subtle ways on a vast array of sites to provide an extra dimension to layouts. The familiarity of these textures stands as a testament to the widespread usage of Fireworks in the world of web design. Figure 6-5 shows how to apply the texture named Line-Diag 1 to a selected rectangle on the canvas.

![Figure 6-5. Applying a texture](image)

These textures are simply a collection of bitmaps stored in the Configuration\Textures folder of your Fireworks CS4 installation directory. You can add your own textures to this folder to have them appear in this list, or you can simply click Other at the bottom of the menu to browse to a custom bitmap.
Blend modes

Blend modes are often confusing to many designers. The Blend mode names (like Color Dodge, Color Burn, Screen, etc.) are based on predigital photo development techniques that few people are familiar with anymore. However, once you get a taste for the power that blend modes offer, you’ll forget you ever had a problem with their weird names.

You can change a blend mode in two places: in the Layers panel and in the Property inspector. Figure 6-6 demonstrates how to change the blend mode via the Layers panel, while Figure 6-7 demonstrates how to change the blend mode via the Property inspector.

Figure 6-6. Changing the blend mode from the Layers panel

Figure 6-7. Changing the blend mode from the Property inspector
Blend modes affect the way objects are blended with other objects beneath them in the Layers panel. Draw two red rectangles side by side, and then draw a gradient-filled rectangle and position it beneath the first two. Change one of the rectangle’s blend modes to Lighten. Step through the various blend modes available and observe how the resulting visual changes. And remember, the blend mode applied to an object affects the way that object is blended with the pixels beneath it. In the sections that follow, you’ll see how these seemingly mysterious modes can enable some beautiful visual effects.

Filters

Filters, or plug-ins as they’re also known, allow you to create visuals that cannot be achieved with the standard design tools alone. (If you’ve worked in Photoshop, you know these as Live Effects.) Filters are applied to their underlying objects at the pixel level and can be used to add a level of photorealism to standard vector-based or bitmapped artwork. Soft glows and drop shadows are filter based, for example. In Fireworks, you can apply any combination of a number of built-in filters (such as Drop Shadow or Gaussian Blur) to objects on the canvas, and then tweak those effects infinitely, all while your underlying object is preserved. If you don’t like a particular effect, you can simply remove the filter.

Fireworks pioneered this concept, known as Live Filters. Prior to Fireworks, tools like Photoshop forced you into a very linear pattern, rendering the effect directly to the target object. In order to test variations of the effect, you had to undo the effect, and then reapply with different settings. Changing your mind several steps later was not an option. Fireworks changed the paradigm, introducing the concept that filters are attached to an underlying object. Much to the delight of designers everywhere, most tools (like Photoshop) have followed Fireworks’ lead and now support the Live Filters concept.

Why use filters?

It’s actually amazing what can be achieved without filters. You can create surprisingly complex visuals and layouts using a combination of techniques, relying purely on different fill types (solid, linear gradient, radial gradient, etc.) and varying degrees of opacity. Filters, however, bring an entirely new dimension of possibilities to the table. Filters like Gaussian Blur can be used to create a sense of depth or make an object feel “soft” in a way that cannot be achieved purely with a fill. The Drop Shadow effect can quickly give your object a 3D appearance and adds an element of pseudo-reality that is common in modern design. The color filters, such as Brightness/Contrast and Hue/Saturation, give you the power to alter the color of the underlying object in a way that is difficult (or impossible) using the fill tools alone.

Applying filters

Instead of diving headfirst into a complex filter-based effect, we’ll first cover the basics of filters in Fireworks. Like the majority of property editing, filter-editing takes place in the Property inspector. Figure 6-8 shows the Add Filter menu, available in the Property inspector when an object is selected on the canvas.
Fireworks filters are divided into a number of categories on the fly-out menu. In Figure 6-8, we’ve selected the Gaussian Blur filter from the Blur category. Once selected, we immediately get a Gaussian Blur dialog, as shown in Figure 6-9.

After adjusting the Blur radius setting and clicking OK, a Gaussian Blur entry is added to the applied filters list. As you apply more filters to your object, you’ll see those filters added to the list as well. Figure 6-10 shows the filter list for an object that has the Gaussian Blur, Drop Shadow, and Hue/Saturation filters (obscured from view) applied.
At any point in time you can modify the filter settings by clicking the blue information icon next to the filter. Toggle the visibility of a filter by checking and unchecking its check box, or remove a filter completely by selecting it in the list and clicking the Delete button next to the Add button (the minus sign currently grayed out). Reorder filters simply by dragging them in the list.

Figure 6-11 shows a number of basic filters applied to the same rectangle. Experiment with the base filters to get a feel for their flexibility and limitations. Try combining them now to see how they play together.

![Figure 6-11. Basic filters](image)

The ability to infinitely modify, reorder, add, and remove effects to an object is just one of the many reasons Fireworks users are passionate about their tool. This flexibility is going to come into play as we step through creating a number of popular effects.

**Styles**

Styles in Fireworks CS4 are similar in concept to CSS classes, only much more powerful. A style in Fireworks can represent all of the settings that can be applied to an object, including the fill settings, stroke settings, text settings, and effects. Fireworks CS4 actually ships with a large number of prebuilt styles that can both speed up your design process and serve as excellent teaching tools.

Open the Styles panel (Window ➤ Styles) and select Plastic Styles from the list of libraries. Figure 6-12 shows the Styles panel with the library selector expanded.

Once you’ve selected a prebuilt library, first select a target object or set of objects on the canvas, and then select one of the styles from the library. When you apply a style, two things happen:

![Figure 6-12. Selecting a style library](image)
The style is copied to the current document's style library.

A reference to the style is added to the target object.

Instead of simply applying the settings housed in the style to the target object, a reference to the style is added to the object. This means that any time the style is changed, all objects referencing that style are updated. Figure 6-13 shows a rectangle that has the Plastic 011 style (from the Plastic Styles library) applied. Change the library in your Styles panel to Current Document, and you’ll see that the Plastic 011 style has been copied to your document, along with all other styles present in Current Document.

![Image](image.png)

**Figure 6-13.** Reviewing applied styles in the Property inspector

### Creating popular effects

With the basics out of the way, it’s now time to move on to the fun stuff! Let’s start by creating a popular effect that doesn’t appear to be going away anytime soon—the glass effect.

### Creating glass buttons

Glass buttons were made popular years ago with their introduction on Apple’s web site and in Mac OS X. If you search the Web, you’ll still find countless tutorials for creating Mac OS X–style buttons. However, since that introduction years ago, the glass effect has become so pervasive that its relationship to Mac OS X has almost been forgotten. Where you once may have been accused of copying the
“Apple look” by adding glass buttons, you’re now just adding a key element in modern graphic design. Glass is no longer an add-on feature, it’s an expected practice.

You can employ a number of techniques to achieve the glass look. Most involve laying down either a base solid or base gradient, and then applying a white-based gradient in the foreground to create the appearance of refracted light. We’ll start by creating the basic two-piece glass button.

Draw a rectangle 160 px (pixels) wide by 40 px tall. Apply a linear gradient that starts with a shade of blue and ends with a slightly lighter version of that blue. In Figure 6-14, you can see that we added a highlight color at the end of our gradient to give the resulting button a little more depth. We’ve also set the rectangle roundness to 11 px.

![Figure 6-14. Defining the glass button base](image)

Now to catch the light, draw another rectangle in the foreground that is roughly 50% of the height of the base rectangle. It should be inset by 1 px on the left, top, and right. Apply a linear gradient with white color stops at the beginning and end of the gradient. The opacity stops are what we’re concerned with at this point. Figure 6-15 shows the Opacity tab of the Gradient panel selected. You can see that we’ve set the opacity of the first (topmost) node to 90% and the opacity of the second node to 20%. Adjust these values to achieve the desired amount of “glass.”
Generally, for the effect to work well, you need a base object that goes from dark at the top to a lighter color at the bottom, or a solid base color. In our base object, we added an extra highlight color at the very bottom of the base object, simulating another light source. This technique can give your object even more depth.

Before adding text, we want to help the button stand out from the background just a bit more. We can achieve this by applying a Glow filter to the base rectangle. Figure 6-16 shows the settings we used for the Glow filter. We chose a color toward the lighter end of the base rectangle’s gradient fill. This is another area where you can refine your settings infinitely to achieve the look you’re after.

With the body of the button complete, it’s now time to add the final element—the text. Center your text in the button horizontally and vertically, and set the fill color to white. To increase the legibility of your text and create additional depth, you can once again take advantage of the Glow filter. Figure 6-17 shows the settings we used for a Glow filter applied to the text object. This time we chose a color from the darker end of the base rectangle’s gradient fill.
As we mentioned at the beginning of this section, there are a number of variations on this technique. Apply some of the styles from the Plastic Styles library to see how glass can be created using a single object. Instead of using a foreground rectangle to create the highlight, a single gradient is used to create a similar effect. The single gradient technique is useful when you need to resize your glassy objects frequently. Instead of having to adjust both your base rectangle and highlight rectangle every time you resize, you can simply adjust the gradient handles.

Creating reflections

Reflection effects, like glass effects, are not going away anytime soon. And again, like glass effects, the judicious use of simulated reflections in your layout can lend a polished, contemporary look to your design. We won’t attempt to define the parameters of judicious though; we’ll just show you how to create this effect and leave the judgment of when to use this effect up to you.

Let’s create a reflection of the glass button we just created. Start by removing the Glow filter from the base rectangle. We think the glow will interfere with the reflection. Next, select all of the elements used to make the button and press F8 to create a symbol. Name the symbol GlassButton in the Convert to Symbol dialog that appears. (We’re having you create a symbol so that you only have to update the text in one place once your reflection is in place.)

With the symbol created, copy and paste the button and position the copy directly beneath the original, leaving a 1- to 2-px space between the two objects. Flip the copy by selecting Modify ➤ Transform ➤ Flip Vertical from the main menu. Your canvas should look like Figure 6-18 at this point.

With the object positioned and flipped, it’s now time to add a linear gradient opacity mask. The fastest way to do this is via the Commands menu. With your reflected object selected, select Commands ➤ Creative ➤ Auto Vector Mask from the main menu. Select the preset from the lower-left corner of the resulting dialog, as shown in Figure 6-19.
Figure 6-19. Applying an auto vector mask

After clicking Apply, a new vector mask is added to the selected object. When selected, we can adjust the gradient handles just like adjusting any other gradient fill. The mask remains editable even after moving on to other things. Simply click the mask icon next to the object preview in the Layers panel, as shown in Figure 6-20.

Figure 6-20. Selecting an object’s mask

The Auto Vector Mask command got us close but not all the way. We do need to adjust the mask a bit to create an acceptable reflection effect. In Figure 6-21, we’ve moved the start handle of the gradient
above the reflected object itself, set the reflected object’s opacity to 70%, and changed the background from white to black.

![Glass Button](image1)

**Figure 6-21.** Final reflection

As with the reflection effect, you may want to tweak this effect for your personal needs and design goals: the opacity of the reflection, the point where the reflection fades out completely, and the amount of space between the source object and reflection object are all areas of customization. Further, these settings generally change as the color of your background changes. This same approach works for any object on the Fireworks design surface, including plain text objects and bitmaps.

**Creating web headers**

When designing web layouts, most start by focusing on the design of the header. The header is the first thing site visitors encounter. It defines both the brand (even if it’s a personal blog) and personality of the site, and it serves as an anchor for the page. We’re going to teach you how to replicate a common look seen across many commercial and powerful sites. You’ll see how the Fireworks foundational tools we looked at in the beginning of this chapter make this exercise a cinch. First, let’s take a look at where we’re going. Figure 6-22 shows the final header for “My Web Site.”

![My Web Site](image2)

**Figure 6-22.** Final web header

The style of the header should be familiar, just as the glassy button and reflection effect before it were. This header includes a number of popular techniques: diagonal textures of varying degrees of thickness; a sharp, glass-like foreground effect; the Helvetica Rounded font, with a double-stroke and subtle glow applied; and additional text-based textures. The palette was chosen from among thousands at the kuler site (http://kuler.adobe.com), a great resource and tool you’ll want to use if you don’t know about it already.
Finding the right color palette

Before you dive into your layout, it's important to start with a color palette. The header in Figure 6-22, as we just mentioned, is based on a color palette we found on kuler. Figure 6-23 shows the five swatches of this palette.

We used the bright blue as the starting color for the header, and then applied the lime green as our “pop” color—the result is a text treatment that really stands out from the background.

The color palette values are as follows:

- #13140F
- #D4FF00
- #E4FFE6
- #68776C
- #00D6DD

Creating the thick diagonal background texture

As you've already seen, Fireworks ships with a number of textures, including a few diagonal line textures. However, those diagonal line textures are just 1-px thick; to achieve the look we're going for (and the look you’ve seen on countless sites), we need a heavier line. Fortunately for us, creating additional textures is easy. Figure 6-24 shows a 10×10 px black-and-white image that we created in just a few minutes.

When creating custom textures, it's important to remember that the white areas are opaque and the black areas are transparent. It's a little confusing at first, but with a little practice, you'll get the hang of it. With your custom texture created, export it as a 32-bit PNG to a location of your choosing before moving on to the next step.

Defining the container rectangle

Start by creating a new document approximately 700×200 px in size. Set the document’s background color to black, and then draw a rectangle 600×128 px in size. Now, set the rectangle roundness to 14 px. We applied the darker of the two blues from the color palette to this rectangle (solid fill #68776C).

With the shape defined and the fill color set, it's now time to apply our custom texture. Click the Texture button, and then select Other from the menu that appears. Browse to the texture you saved in the previous step and click OK. Your custom texture should now be applied. We're almost finished with this element—just a couple of additional settings to make before we move on. Check the Transparent check box option beneath the texture list and set the opacity of the texture to 100%. This ensures that the texture and only the texture is seen when the rectangle is drawn. Finally, change the opacity of the rectangle itself to 45. Your rectangle should look like the rectangle in Figure 6-25.
Defining the primary rectangle

With the container rectangle in place, draw another rectangle inside the bounds of the previous rectangle (you may want to lock the previous rectangle to prevent accidental selection). It should be 16 px smaller on both axes to create an 8-px border all the way around. Final dimensions: 644×112 px. Reduce the roundness on this rectangle to 12 px to ensure symmetry with the larger container rectangle. Now, apply a vertical linear gradient based on the primary blue color of our palette. Figure 6-26 shows our final gradient applied. The primary blue has been positioned at approximately 60%, and we’ve set the first color stop to a slightly darker version of the same color.

Adding texture to the primary rectangle

Let’s take this diagonal theme a little further and apply a finer-grained diagonal texture to the foreground of our primary rectangle. Start by copying and pasting the last rectangle. Now apply the Line-Diag 1 texture, again checking Transparent and setting the texture opacity to 100%. Finally, apply a vertical linear gradient that goes from 60% opacity at the top to 0% opacity at the bottom. Both color stops should be white. Your latest layout should look like Figure 6-27.
Adding a highlight border

You may not have noticed it when you first saw the layout at the beginning of this section, but the container has a 4-pixel-thick white border that fades vertically from opaque to transparent. Once again, create a copy of the last rectangle and paste it in the foreground of the other rectangle. Clear the rectangle’s fill and apply a 4-pixel white stroke. Select the Basic ➤ Soft Line preset from the Stroke category menu in the Property inspector. Now, click the Stroke category button again and select Stroke Options from the menu, as shown in Figure 6-28.
From the Stroke Options dialog, change the location of the stroke to Stroke Inside, as shown in Figure 6-29.

![Figure 6-29. Setting the location of the stroke](image)

The stroke is now drawn from the edge of the rectangle in. This prevents the stroke from overlapping the background texture we created in the first step. With the rectangle still selected, select Commands ➤ Creative ➤ Add Vector Mask from the main menu, and, as before, select the vertical gradient preset in the lower-left corner of the dialog. Your border should now fade from the top to the bottom. To prevent the border from fading out completely, change the value of the black opacity stop to #313131 so that a touch of the border is still along the bottom edge. Your layout should now look like Figure 6-30.

![Figure 6-30. White border in place](image)

**Adding text elements**

Are you sick of rectangles yet? Now's your chance for a brief break as we focus on the text elements of the header. Using the Text tool, add the name of your site to the header. The font settings are shown in Figure 6-31; of note are the position (41,54) and font size. You also need to apply green as the foreground (#D4FF00).
Figure 6-31. Text settings

We’re now going to add a stroke to the text, but on a copy of the text block, not on the current text block. Copy and paste the current text block, and then either select the original from the Layers panel or move the currently selected copy behind the original by pressing Ctrl+down arrow (Cmd+down arrow on a Mac). Now apply a 2-px stroke to the text block using the darker blue in our color palette (#68776C). To set the stroke thickness on a text block, you have to launch the Stroke Options dialog like we did earlier to set the location of the stroke.

Now, copy and paste the text block one more time, and move the copy behind the previous two text block instances. Apply a white stroke that is 4-px thick. Also apply a white glow with a width of 0 px, opacity of 54%, and softness of 9. The final result is shown in Figure 6-32.

Figure 6-32. Creating the main title

The subtitle “a me production” is created using the same technique, only you start with the darker blue text and apply a white stroke. You also need to add the text “2009” to the lower-right area of the primary rectangle. Use the light blue from our color palette (#E4FFE6), set its opacity to 40%, and bump the font size to 50.
Adding foreground glass

See, we told you glass was pervasive! We also told you that there are a number of techniques and variations of approaches employed when creating the glass effect. This header employs a technique slightly different from what you saw with the glass button previously. Start by drawing a rectangle that is approximately 50% of the height of the primary rectangle; ours is 55-px tall. Now apply, you guessed it, a white-based vertical gradient. This time, however, we’ll go from transparent at the top to slightly opaque at the bottom. Because pictures tell a thousand words, take a look at Figure 6-33 to see exactly how we positioned the gradient handles on the design surface and the opacity stops in the gradient definition.

![Figure 6-33. Defining the glass rectangle](image)

With the addition of this last rectangle, we have achieved the look of a modern, Web 2.0–style header. As with the previous effects, there were countless steps along the way that introduce the possibility of customization and personalization.

Adding “magic”

You’ve undoubtedly seen visuals online that look like they have been rendered by some sophisticated 3D particle generator but have, in fact, been created in a 2D program like Fireworks. In the exercise the follows, we’ll employ the use of layer blend modes, blur effects, and the advanced stroke options (Edit Stroke) dialog to create a layout that looks much more difficult to create than it really is.

Start by creating a document approximately 600×400 px with the canvas color set to black. Now, draw a rectangle the same dimensions as your document and set its fill mode to Linear. With the rectangle selected, launch the Fill Options dialog as shown in Figure 6-34.

From the Fill Options dialog, select the Spectrum preset from the gradient presets list, as shown in Figure 6-35.
With the spectrum applied, change the orientation of the gradient to be horizontal (you can adjust this later), and drag the gradient handle so that only the first three colors are visible on the canvas (red, magenta, and blue). Your canvas should now look like Figure 6-36.
Now the fun begins. Change the rectangle’s Blend mode to Multiply and lock the rectangle. Select the Vector Path tool, draw a quick shape similar to the one shown in Figure 6-37, and position it beneath the locked rectangle. Set the stroke color to white.

![Figure 6-37. Defining the initial path](image)

With the path selected, change the stroke setting to Random ➤ Dots from the Stroke category menu. Launch the advanced stroke options (Edit Stroke) dialog and change the Tips setting to 2 on the Options tab. Select the Shape tab, uncheck the Square check box if it’s checked, and change the Size setting to 15. Select the Sensitivity tab and select Size from the Stroke property combo box. Now adjust the value of Speed. By adjusting this value, the size of the stroke is altered along the path depending on the speed at which you drew the path. Take a few minutes to play with this value and draw and redraw the path at varying rates to see how this setting can affect your final visual. Figure 6-38 shows our final stroke settings.
Figure 6-38. Setting stroke properties

With your stroke options in place, your path should now look like the one in Figure 6-39.

Figure 6-39. Path with particle effects
The magic is already starting to happen. You can see more clearly now the effect of the gradient on
the underlying objects. The white of the path is acting like a mask, revealing the gradient fill of the
rectangle. We’ll use several instances of this path to make the effect more dramatic. Copy and paste
two instances in the foreground of the original. Now, select the original and apply a Gaussian Blur filter
with a radius of 7.8. You should now see a soft glow around the dots, almost as if they’re emitting
light.

Copy and paste two more instances of this blurred path, and again select the bottommost path. All of
the previous paths have remained directly on top of each other. Offset this path so that it feels almost
like a nebula of light. Figure 6-40 shows the result after adding these numerous copies.

Figure 6-40. Evolving the particle effect

The particle effect looks nice as is, and you may feel inclined to stop here, but we’re going to create
one more copy of the original path and paste it in the foreground of the rectangle. Pasting it in the
foreground of the rectangle excludes the path from the effects of the Overlay blend mode applied to
the rectangle and makes the particles look more like light sources.
Before adding text elements to this layout, we're going to add some depth to the background by incorporating a few strategically placed circles. Figure 6-41 shows our final background with these circles in place. Each is placed beneath the gradient-filled rectangle, and has a fill of white and an opacity of 46%.

![Figure 6-41. Final background texture](image)

With the background texture complete, we're now going to employ the same technique you just saw, only this time with text. We'll add text both behind the rectangle and in the foreground of the rectangle. The text in the foreground is simply white with no effects, while the text behind the rectangle has a Gaussian Blur applied to create a nice glow. Try experimenting with the number of copies you create for the glow effect, adjusting the amount of blur applied to each layer. Figure 6-42 shows the final layout with the text effects added.
Summary

You’ve now seen how to create a number of popular effects using Fireworks and Fireworks alone. While we’ve in no way covered every effect possible, we’ve covered the core set of techniques within Fireworks required to achieve the majority of visual effects possible with the tool. With these core techniques under your belt, you should now be empowered to tackle and understand practically any tutorial you find online.

The same flexibility that makes Fireworks great for layout (e.g., infinitely editable paths and rectangles) makes Fireworks great for effects. Your choices are always reversible and tweakable, which is a very comforting thing. Now, go create something amazing!